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On	this	page	Note:	Sharing	options	vary	by	group	size:	Up	to	100:	You	can	let	up	to	100	people	with	view,	edit,	or	comment	permissions	work	on	a	Google	Docs,	Sheets,	or	Slides	file	at	the	same	time.	100	or	more:	When	100	people	or	more	are	accessing	a	file,	only	the	owner	and	some	users	with	editing	permissions	can	edit	the	file.	To	let	more	than
100	people	view	your	file	at	the	same	time,	publish	it	as	a	web	page	instead.	Select	the	file	you	want	to	share.	Click	Share	or	Share	.	Enter	the	email	address	or	Google	group	you	want	to	share	with.	To	decide	what	role	people	will	have	on	your	file,	select	Viewer,	Commenter,	or	Editor.	If	your	account	is	eligible,	you	can	add	an	expiration	date	for
access.	Choose	to	notify	people.	If	you	want	to	notify	people	that	you	shared	an	item	with	them,	check	the	box	next	to	Notify	people.	If	you	notify	people,	each	email	address	you	enter	will	be	included	in	the	email.	If	you	don't	want	to	notify	people,	uncheck	the	box.	Click	Send	or	Share.	Learn	more	at	the	Drive	Help	Center	You	can	choose	if	your	file
should	be	available	to	anyone	or	restricted	to	only	the	people	with	access.	If	you	allow	access	to	anyone	with	the	link,	your	folder	won't	restrict	who	can	access	it.	Select	the	file	you	want	to	share.	Click	Share	or	Share	.	Under	“General	access”,	click	the	Down	arrow	.	Choose	who	can	access	the	file.	Learn	more	at	the	Google	Docs	Editors	Help	Center
Stop	sharing	a	document	you	own	Find	the	file	or	folder	in	Google	Drive,	Google	Docs,	Google	Sheets,	or	Google	Slides.	Open	or	select	the	file	or	folder.	Click	Share	or	Share	.	Find	the	person	you	want	to	stop	sharing	with.	To	the	right	of	their	name,	click	the	Down	arrow			Remove	access.	Click	Save.	Restrict	access	to	a	spreadsheet	you	own	Learn
more	at	the	Google	Docs	Editors	Help	Center	On	your	computer,	open	a	document,	spreadsheet,	presentation,	or	video.	Highlight	the	text,	images,	cells,	slides,	or	scenes	you	want	to	comment	on.	To	add	a	comment,	in	the	toolbar,	click	Add	comment	.	Type	your	comment.	Click	Comment.	Chat	with	collaborators	in	a	spreadsheet	On	your	computer,
open	a	document,	spreadsheet,	or	presentation.	At	the	top	right,	click	Show	chat	.	This	feature	won't	be	available	if	you're	the	only	one	in	the	file.	Tip:	If	there	are	many	collaborators	in	the	file,	at	the	top	right,	to	the	right	of	the	avatars,	there	will	be	a	blue	circle	showing	the	number	of	additional	collaborators.	Click	the	blue	circle		Join	chat	.	Enter
your	message	in	the	chat	box.	When	you’re	finished,	at	the	top	right	of	the	chat	window,	click	Close	.	Note:	All	chats	in	Google	Docs,	Sheets,	and	Slides	include	anyone	viewing	the	file.	The	chats	aren't	saved.	Back	to	top	Google,	Google	Workspace,	and	related	marks	and	logos	are	trademarks	of	Google	LLC.	All	other	company	and	product	names	are
trademarks	of	the	companies	with	which	they	are	associated.	SearchClear	searchClose	searchGoogle	appsMain	menu	One	of	the	best	features	of	online	applications	like	Google	Docs,	Sheets,	and	Slides	is	the	ability	to	share	documents.	Whether	you	want	to	collaborate	in	real-time	or	simply	let	others	view	the	document,	it's	easy	enough.	However,
there's	more	to	sharing	your	document	than	just	a	button	click.	Depending	on	what	you're	sharing	and	with	whom,	you	should	take	a	moment	to	consider	the	sharing	permissions.	Should	others	have	the	ability	to	edit	the	document?	Do	you	want	them	to	be	able	to	add	comments?	Or	should	the	document	be	view-only?	Let's	walk	through	how	to	share
your	documents	and	the	permission	options.	Set	Up	Sharing	With	Specific	People	Google	keeps	things	consistent	when	it	comes	to	sharing	in	all	three	applications.	So	you	can	follow	the	same	steps	regardless	of	which	application	you're	using.	For	this	how-to,	we'll	use	Google	Docs	as	an	example.	When	you're	ready,	click	"Share"	on	the	top	right.
Alternatively,	you	can	click	File	>	Share	from	the	menu.	Enter	the	name	of	your	contact	or	email	address	of	the	person	you'll	share	with.	You	can	enter	more	than	one	person	if	you	like.	Just	note	that	if	you	do	share	with	more	than	one	person	and	adjust	the	sharing	permissions	at	this	stage,	you	cannot	set	the	permissions	individually.	However,	you
can	change	them	per	person	after	you	share	the	document,	which	we'll	also	cover	below.	Adjust	the	Sharing	Permissions	To	the	right,	use	the	drop-down	box	to	choose	the	permission.	You	can	choose	Editor,	Viewer,	or	Commenter.	Editor:	They	can	make	changes,	accept	or	reject	suggestions,	and	share	the	document	with	others.	Viewer:	They	can
only	view	the	document.	They	cannot	make	changes	or	share	the	document.	Commenter:	They	can	only	add	comments	and	make	suggestions.	They	cannot	make	changes	or	share	the	document.	The	above	are	default	permission	settings,	but	you	can	make	a	couple	of	adjustments	if	you	like.	In	the	sharing	window,	click	the	gear	icon	on	the	top	right.
Here	you	can	disallow	editors	from	changing	permissions	and	sharing.	And	you	can	disable	the	ability	for	viewers	and	commenters	to	see	the	download,	print,	and	copy	actions.	Uncheck	the	boxes	to	remove	those	permissions	per	your	preference.	Once	you	add	the	person	or	people	you	want	to	share	with	and	set	the	permissions,	you	can	optionally
check	the	box	to	Notify	People	and	add	a	message.	This	will	send	an	email	to	them	letting	them	know	you've	shared	a	document	with	them.	Click	"Send."	If	you	don't	want	to	notify	those	you're	sharing	with	here,	be	sure	to	uncheck	the	Notify	People	box	and	click	"Share."	You	may	choose	to	do	this	if	you	want	to	notify	them	yourself	with	your	own	link
to	the	document.	If	you	plan	to	share	your	document	with	many	people,	you	have	the	option	to	grab	a	link	to	the	document	instead.	And	with	this	option,	you	can	set	permissions	as	well.	Click	"Share"	and	then	click	inside	the	Get	Link	area	of	the	Sharing	window.	You	then	have	two	options	in	the	drop-down	box,	Restricted	and	Anyone	With	the	Link.
Use	Restricted	in	conjunction	with	adding	specific	people	in	the	area	above.	This	restricts	anyone	other	than	the	people	you	share	with	from	accessing	the	document	if	they	come	across	the	link.	Use	Anyone	With	the	Link	to	allow	anyone	with	it	to	access	the	document.	Then	to	the	right,	choose	Viewer,	Commenter,	or	Editor.	This	permission	will	apply
to	everyone	accessing	the	document	using	the	link.	You	can	then	copy	the	link	to	share	with	others.	Then,	click	"Done."	Whether	you	share	with	specific	people	or	simply	share	the	link,	you	can	change	the	permissions	you	initially	set	up.	Click	"Share"	on	the	top	right.	For	specific	people,	use	the	top	part	of	the	share	window.	Select	the	drop-down	box
next	to	the	person	you	want	to	change	the	permission	for	and	choose	the	new	setting.	Click	"Save."	For	anyone	with	a	link,	use	the	bottom	part	of	the	share	window.	Select	the	new	permission	in	the	drop-down	box	on	the	right.	Click	"Done."	If	necessary,	you	can	stop	sharing	a	document	just	as	easily.	Again,	click	"Share."	For	specific	people,	open	the
drop-down	box	to	the	right	of	the	person	and	select	"Remove."	For	anyone	with	the	link,	you	can	change	the	setting	to	Restricted.	Then	make	sure	to	remove	anyone	from	the	sharing	list	in	the	above	section	whom	you	don't	want	to	have	access.	Google	offers	other	ways	to	collaborate	with	colleagues	too.	You	can	use	comments	in	Google	Sheets	to
collaborate	on	spreadsheets	and	create	documents	and	work	together	directly	in	Google	Chat.	On	this	page	Note:	Sharing	options	vary	by	group	size:	Up	to	100:	You	can	let	up	to	100	people	with	view,	edit,	or	comment	permissions	work	on	a	Google	Docs,	Sheets,	or	Slides	file	at	the	same	time.	100	or	more:	When	100	people	or	more	are	accessing	a
file,	only	the	owner	and	some	users	with	editing	permissions	can	edit	the	file.	To	let	more	than	100	people	view	your	file	at	the	same	time,	publish	it	as	a	web	page	instead.	Select	the	file	you	want	to	share.	Click	Share	or	Share	.	Enter	the	email	address	or	Google	group	you	want	to	share	with.	To	decide	what	role	people	will	have	on	your	file,	select
Viewer,	Commenter,	or	Editor.	If	your	account	is	eligible,	you	can	add	an	expiration	date	for	access.	Choose	to	notify	people.	If	you	want	to	notify	people	that	you	shared	an	item	with	them,	check	the	box	next	to	Notify	people.	If	you	notify	people,	each	email	address	you	enter	will	be	included	in	the	email.	If	you	don't	want	to	notify	people,	uncheck	the
box.	Click	Send	or	Share.	Learn	more	at	the	Drive	Help	Center	You	can	choose	if	your	file	should	be	available	to	anyone	or	restricted	to	only	the	people	with	access.	If	you	allow	access	to	anyone	with	the	link,	your	folder	won't	restrict	who	can	access	it.	Select	the	file	you	want	to	share.	Click	Share	or	Share	.	Under	“General	access”,	click	the	Down
arrow	.	Choose	who	can	access	the	file.	Learn	more	at	the	Google	Docs	Editors	Help	Center	Stop	sharing	a	document	you	own	Find	the	file	or	folder	in	Google	Drive,	Google	Docs,	Google	Sheets,	or	Google	Slides.	Open	or	select	the	file	or	folder.	Click	Share	or	Share	.	Find	the	person	you	want	to	stop	sharing	with.	To	the	right	of	their	name,	click	the
Down	arrow			Remove	access.	Click	Save.	Restrict	access	to	a	spreadsheet	you	own	Learn	more	at	the	Google	Docs	Editors	Help	Center	On	your	computer,	open	a	document,	spreadsheet,	presentation,	or	video.	Highlight	the	text,	images,	cells,	slides,	or	scenes	you	want	to	comment	on.	To	add	a	comment,	in	the	toolbar,	click	Add	comment	.	Type	your
comment.	Click	Comment.	Chat	with	collaborators	in	a	spreadsheet	On	your	computer,	open	a	document,	spreadsheet,	or	presentation.	At	the	top	right,	click	Show	chat	.	This	feature	won't	be	available	if	you're	the	only	one	in	the	file.	Tip:	If	there	are	many	collaborators	in	the	file,	at	the	top	right,	to	the	right	of	the	avatars,	there	will	be	a	blue	circle
showing	the	number	of	additional	collaborators.	Click	the	blue	circle		Join	chat	.	Enter	your	message	in	the	chat	box.	When	you’re	finished,	at	the	top	right	of	the	chat	window,	click	Close	.	Note:	All	chats	in	Google	Docs,	Sheets,	and	Slides	include	anyone	viewing	the	file.	The	chats	aren't	saved.	Back	to	top	Google,	Google	Workspace,	and	related
marks	and	logos	are	trademarks	of	Google	LLC.	All	other	company	and	product	names	are	trademarks	of	the	companies	with	which	they	are	associated.	SearchClear	searchClose	searchGoogle	appsMain	menu	When	it	comes	to	collaboration,	no	other	spreadsheet	program	can	beat	Google	Sheets.	Even	then,	Google	can	be	a	little	cumbersome	when	it
comes	to	sharing,	especially	if	you	want	to		share	a	specific	tab	in	Google	Sheets.	Often,	when	you	try	to	share	a	document,	Google	Sheets	tries	to	share	the	entirety	of	the	document	—	and	that’s	not	always	what	you	want.	If	you	landed	here,	you	must	have	been	asking	yourself,	“Can	Google	Sheets	Share	Only	One	Tab?”	Unfortunately,	there	isn’t	an
internal	way	to	share	only	a	single	sheet	in	Google	Sheets.	Rather,	you	need	to	get	a	little	creative.	Let’s	take	a	look	at	how	to	share	only	one	sheet	in	Google	Sheets.	Can	You	Share	Only	One	Tab	in	Google	Sheets?	There	may	not	be	an	internal	way	to	share	specific	sheets	on	Google	Sheets,	but	you	can	do	so	by	hiding	the	sheets	you	don’t	want	to	be
seen.	Here’s	how	to	share	one	sheet	in	Google	Sheets:	Go	to	the	sheet	you	don’t	want	to	share.	Click	the	dropdown	menu.	Choose	Hide	sheet.	Go	to	the	sheet	you	want	to	share	Copy	the	link	and	share	it	with	the	other	user.	When	the	user	clicks	the	link,	they	will	be	taken	to	the	specific	sheet	you	want	to	share,	and	they	shouldn’t	be	able	to	see	the
other	sheet.	However,	this	doesn’t	mean	that	they	completely	lack	access	to	these	sheets	since	there’s	an	option	to	unhide	hidden	sheets.	Learn	Faster	Often,	the	most	efficient	way	to	improve	your	spreadsheet	skills	is	to	use	some	kind	of	structured	learning.	We	recommend	using	a	Udemy	Google	Sheets	course	to	streamline	your	learning.	The
Design	of	a	Google	Sheet	If	you’re	familiar	with	Excel,	you’re	familiar	with	Google	Sheets.	A	“Google	Sheet”	document	is	a	single	document	—	known	as	a	“workbook”	—	composed	of	multiple	pages.	Read	more:	Does	Google	Sheets	Work	Like	Excel?	Usually,	when	you	share	a	document	on	Google	Sheets,	you’re	sharing	the	entire	document.	In	this
example,	we	have	a	sheet	that	contains	our	employee	schedules.	We	have	one	page	for	“Anna”	and	another	page	for	“Aaron.”	Understandably,	we	just	want	to	share	the	schedule	with	employees	on	an	individual	basis.	But	we	may	want	to	keep	everything	in	a	single	sheet	for	simplicity’s	sake.	The	most	common	method	of	Google	spreadsheet	sharing
only	one	sheet	is	to	click	on	the	“Share”	button.	From	there,	you	can	either	“Add	People	or	Groups”	or	get	a	shareable	link.	When	sharing,	you	can	choose	one	of	three	classifications:	Viewer:	This	is	someone	who	can	view	the	content	but	cannot	comment	or	edit	it.	Commenter:	This	is	someone	who	can	leave	comments	but	cannot	edit	the	document
itself.	Editor:	This	is	someone	who	can	view	content,	leave	comments,	and	edit	the	file.	Usually,	you	should	share	most	documents	as	“commenter”	or	“viewer.”	When	you	allow	people	to	edit	your	documents,	you	run	the	risk	of	losing	content	or	changes.	If	you	do	allow	others	to	edit	your	documents,	you	will	be	able	to	track	the	given	changes.	You’ll
see	who	edited	what	and	when	and	be	able	to	revert	changes	if	desired.	Still,	it	is	dangerous,	and	someone	could	potentially	share	your	file	with	others	who	shouldn’t	have	it,	or	delete	the	file	altogether.	An	issue	with	sharing	a	file,	however,	is	that	it’s	going	to	share	the	whole	spreadsheet	—	it’s	not	going	to	work	if	you’re	interested	in	sharing	only
one	single	tab.	If	you	want	to	share	only	one	tab	in	Google	Sheets,	you’re	usually	going	to	have	to	remove	the	extraneous	data	from	the	document.	There	are	a	few	methods	you	can	use	to	do	this.	Can	Google	Sheets	Share	Only	One	Tab	By	Linking	to	it?	Let’s	say	that	Aaron	knows	exactly	when	Anna	works,	regardless	—	you’re	not	trying	to	hide
information.	You	just	want	to	make	sure	he	ends	up	on	the	right	sheet.	If	he	just	opens	the	URL,	he’s	going	to	end	up	on	Anna’s	page	and	could	get	confused.	It’s	possible	to	link	someone	directly	to	a	specific	tab	in	your	Google	Sheets.	You	do	so	by	first	going	to	the	sheet	that	you	want	them	to	view.	When	you’re	on	the	first	page,	you’ll	see	gid=0	at
the	end	of	the	URL.	But	in	this	case,	when	we	click	on	Aaron’s	tab,	we	see	gid=2068619782.	Add	“gid=2068619782”	to	the	end	of	your	shareable	URL,	and	they’ll	be	automatically	directed	toward	the	appropriate	tab.	The	problem,	of	course,	is	that	you	still	can	see	other	sheets.	You’re	being	directed	to	a	specific	one,	but	can	still	click	on	any	of	them.
So,	while	easier	to	use,	it’s	not	that	secure.	It’s	also	not	an	altogether	intuitive	method	of	sharing	one	Google	Sheet	because	you’re	going	to	need	to	find	the	“gid”	—	and	because	it’s	hard	to	explain	to	someone	what	you	did.	But	if	you’re	just	going	to	be	sending	someone	a	URL	and	you	don’t	particularly	care	if	they	can	see	the	other	data,	this	is	the
best	solution	available.	Protecting	Sheets	from	Being	Viewed	by	Other	Users	What	if	employees	shouldn’t	see	the	schedules	of	other	employees?	Perhaps	the	sheets	also	contain	privileged	information,	such	as	pay	scales.	There	may	come	a	time	when	you	need	to	share	a	sheet	and	protect	the	other	sheets	from	view.	In	this	workbook,	we	also	have	a
sheet	called	payroll	information.	Anna	makes	more	than	Aaron,	likely	because	she	has	seniority	or	perhaps	because	she	has	some	additional	responsibilities.	Luckily,	there	is	a	hide	feature	that	lets	Google	Sheets	hide	tabs	from	certain	users.	You	can	right-click	on	the	sheet	and	click	on	“Hide”	to	hide	this	from	users.	As	long	as	users	are	“Commenter”
or	“Viewer,”	they	aren’t	going	to	be	able	to	edit	the	sheet	to	un-hide	this	page.	But	that’s	not	very	secure.	The	problem	with	this	is	that	you	are	going	to	have	to	“un-hide”	the	sheet,	like	so:	When	you	un-hide	the	sheet,	someone	else	may	be	able	to	see	it.	And,	if	you	have	multiple	users,		you’re	only	going	to	be	able	to	hide	everything	from	everyone	at
once,	not	just	one	thing	from	one	person	at	a	time.	Protecting	Other	Sheets	It	should	also	be	noted	that	you	can	set	protections	for	sheets.	Protections	mean	that	people	cannot	edit	those	sheets	even	if	they	can	view	them.	Google	Sheets	let	you	set	permissions	so	that	other	users	have	limited	access	to	the	spreadsheet.	For	instance,	you	might	set	it	so
that	Anna	cannot	edit	Aaron’s	sheet,	and	Aaron	cannot	edit	Anna’s.	This	would	be	very	convenient	if	you	were	asking	them	to	set	their	own	schedules	and	didn’t	care	whether	they	could	each	view	each	other’s	sheets.	You	can	do	this	by	right-clicking	on	a	sheet	at	selecting	“Protect	Sheet.”	From	there,	you	select	the	users	who	are	able	to	make
modifications	to	the	sheet.	In	fact,	in	this	situation,	it	might	even	be	the	best	solution	to	this	particular	problem	—	they	would	be	able	to	see	each	other’s	sheets	to	check	their	schedules,	but	not	be	able	to	edit	them.	Obviously,	the	downside	again	is	that	you	aren’t	able	to	hide	information	in	this	way.	You	can	just	protect	it	from	being	altered.	If	you
have	privileged	information	on	these	sheets	that	you	want	to	protect,	the	solution	won’t	cut	it.	Share	Only	One	Sheet	Using	the	IMPORTRANGE	Function	You	can	also	use	the	IMPORTRANGE	function	to	share	only	one	sheet	of	a	Google	spreadsheet.	This	method	is	almost	similar	to	creating	a	new	Google	Sheets	file.	You	can	use	the	IMPORTRANGE
function	to	bring	the	data	from	the	sheet	you	want	to	share	into	a	new	spreadsheet.	Here’s	how	to	have	Google	Sheet	share	only	one	tab:	Open	a	new	spreadsheet	Type	the	IMPORTRANGE	formula	into	a	cell.	Copy	the	link	for	the	sheet	you	want	to	share	and	paste	it	into	the	formula,	then	add	a	comma.	Write	the	sheet	name	and	range	in	quotation
marks	and	close	the	brackets.	The	full	formula	for	our	example	is	=IMPORTRANGE(“	0”,	“Sheet1!A1:D10”	)	Hit	Enter	You’ll	see	a	#REF	error	message	which	means	you’ll	have	to	Allow	access.	This	formula	will	import	data	from	the	sheet	into	your	new	spreadsheet,	and	you	can	now	share	the	sheet	on	its	own.	Share	Only	One	Sheet	by	Creating	a
New	File	So	far,	we	have	fairly	imperfect	solutions.	While	we	are	able	to	point	people	to	a	single	sheet,	or	while	we	are	able	to	hide	other	sheets,	we	haven’t	been	able	to	entirely	remove	the	data	that	we’re	trying	to	protect.	But,	as	mentioned,	Google	doesn’t	have	an	internal	method	of	just	sharing	a	single	sheet.	Instead,	you’ll	have	to	actually	create
a	workbook	that	only	has	a	single	sheet	in	it.	An	expedient	way	to	share	a	single	sheet	is	to	first	create	a	copy	of	your	file.	Once	you’ve	created	a	copy	of	the	file,	delete	the	other	pages,	and	then	share	the	sheet	with	the	given	person.	This	has	some	major	privacy	and	security	advantages.	One,	the	data	that	guide	trying	to	protect	is	no	longer	in	the	file
at	all.	You	don’t	need	to	worry	about	whether	they	might	be	able	to	access	it	because	the	data	isn’t	there.	You	also	don’t	need	to	share	it	in	any	special	way;	sharing	it	with	the	individual	is	all	you	need.	But	it	has	some	drawbacks,	too.	You’ll	have	to	update	each	sheet	independently	of	the	larger	document.	You	won’t	be	able	to	retain	links	between	the
sheets	because	they	will	be	separate	workbooks.	And	you’ll	have	a	lot	of	extra	files.	Note:	There	are	also	some	other	ways	that	you	can	create	a	workbook	that	only	contains	one	sheet.	As	an	example,	you	could	create	a	new,	blank	workbook	and	copy	the	sheet	over	manually.	Exporting	Your	Google	Sheets	Page	So,	what	if	you	don’t	want	to	deal	with
multiple	workbooks	but	you	do	want	to	share	a	single	sheet?	There’s	one	final	solution	you	can	try:	exporting	from	the	document.	With	this	method,	you	retain	the	original	workbook.	First,	you	go	to	File	->	Download.	Then,	select	“PDF	Document.”	At	the	very	top,	you’ll	see	“Current	sheet.”	This	lets	you	export	only	the	current	sheet.	This	does	create
an	additional	file	that	you	can	either	share	through	Google	Docs	or	email	as	an	attachment.	But	it	doesn’t	require	alteration	of	the	original	document.	Instead,	you’ll	be	able	to	export	sheet	by	sheet	whenever	you	want	to	share	a	given	page.	And	you’ll	be	aware	that	the	data	that	you’re	trying	to	protect	is	not	in	the	file	that	you’re	sharing.	For	most
people,	this	would	be	the	fastest,	easiest	way	to	share	a	single	sheet	on	Google	Sheets.	The	downside	is	that	you’re	going	to	be	exporting	it	as	a	PDF	document,	which	isn’t	something	that	the	other	person	will	be	able	to	edit	or	share	back	with	you.	Note	that	you	can	also	export	an	XLS	sheet	using	this	method,	but	it	will	export	the	entire	workbook.	If
you	want	to,	you	could	export	an	XLS	sheet	and	then	delete	the	pages	that	you	don’t	want	—	but	that	still	creates	other	issues	because	it	complicates	your	content	pipeline.	Ultimately,	the	goal	is	to	be	able	to	export	a	single	sheet	from	your	Google	Sheet	without	disrupting	the	original	workbook	or	requiring	too	many	steps.	Printing	the	Sheet	Of
course,	it	should	also	be	noted	that	there	is	a	far	more	direct	way	to	share	a	single	sheet.	You	can	always	just	print	the	document.	If	you	print	the	document,	you	can	hand	out	the	sheets	at	will.	The	majority	of	the	time,	the	reason	that	you	would	want	to	share	a	single	page	as	a	Google	Sheet	is	so	the	other	person	can	edit	it.	But	if	it’s	part	of	a	larger
workbook	regardless,	this	would	actually	be	a	chore;	you	would	need	to	bring	the	data	they	change	into	the	original	workbook	when	they’re	done.	If	you	want	to	hand	someone	an	uneditable	copy	of	the	document,	the	fastest,	easiest	way	is	always	going	to	be	to	just	print	the	given	page.	Not	only	does	this	have	the	fewest	potential	security	issues,	but
it’s	also	the	most	straightforward	solution	to	the	technological	problem.	Sharing	Only	One	Sheet	on	Google	Sheets	The	bottom	line:	Google	doesn’t	have	a	specific	process	or	protocol	for	sharing	a	single	sheet.	Rather,	there	are	a	few	workarounds	you	might	use.	You	can	prevent	people	from	editing	specific	sheets,	you	can	hide	sheets,	and	you	can
export	and	share	individual	sheets	from	a	larger	workbook.	This	can	be	a	little	inconvenient.	You	might	have	multiple	pages	of	a	workbook	that	are	all	related	to	each	other,	but	you	might	only	want	certain	people	to	see	a	single	page.	For	most	people,	exporting	a	PDF	copy	of	that	page	—	or	even	printing	the	page	—	may	be	the	easiest	way	to	share
the	information.	When	developing	your	Google	Sheets	documents,	you	might	want	to	keep	this	in	mind.	Consider	the	fact	that	data	shared	in	a	single	sheet	is	likely	to	be	viewable	by	anyone	the	sheet	is	shared	with,	and	that	it	may	be	difficult	for	you	to	share	single	sheets	in	Google	Sheets		without	splitting	up	the	file.	If	you	found	this	article	covering
“Can	Google	Sheets	Share	Only	One	Tab?”	useful,	check	out	our	paid	templates.	You	can	use	the	code	SSP	to	save	50%!	Related:	On	this	page	Note:	Sharing	options	vary	by	group	size:	Up	to	100:	You	can	let	up	to	100	people	with	view,	edit,	or	comment	permissions	work	on	a	Google	Docs,	Sheets,	or	Slides	file	at	the	same	time.	100	or	more:	When
100	people	or	more	are	accessing	a	file,	only	the	owner	and	some	users	with	editing	permissions	can	edit	the	file.	To	let	more	than	100	people	view	your	file	at	the	same	time,	publish	it	as	a	web	page	instead.	Select	the	file	you	want	to	share.	Click	Share	or	Share	.	Enter	the	email	address	or	Google	group	you	want	to	share	with.	To	decide	what	role
people	will	have	on	your	file,	select	Viewer,	Commenter,	or	Editor.	If	your	account	is	eligible,	you	can	add	an	expiration	date	for	access.	Choose	to	notify	people.	If	you	want	to	notify	people	that	you	shared	an	item	with	them,	check	the	box	next	to	Notify	people.	If	you	notify	people,	each	email	address	you	enter	will	be	included	in	the	email.	If	you
don't	want	to	notify	people,	uncheck	the	box.	Click	Send	or	Share.	Learn	more	at	the	Drive	Help	Center	You	can	choose	if	your	file	should	be	available	to	anyone	or	restricted	to	only	the	people	with	access.	If	you	allow	access	to	anyone	with	the	link,	your	folder	won't	restrict	who	can	access	it.	Select	the	file	you	want	to	share.	Click	Share	or	Share	.
Under	“General	access”,	click	the	Down	arrow	.	Choose	who	can	access	the	file.	Learn	more	at	the	Google	Docs	Editors	Help	Center	Stop	sharing	a	document	you	own	Find	the	file	or	folder	in	Google	Drive,	Google	Docs,	Google	Sheets,	or	Google	Slides.	Open	or	select	the	file	or	folder.	Click	Share	or	Share	.	Find	the	person	you	want	to	stop	sharing
with.	To	the	right	of	their	name,	click	the	Down	arrow			Remove	access.	Click	Save.	Restrict	access	to	a	spreadsheet	you	own	Learn	more	at	the	Google	Docs	Editors	Help	Center	On	your	computer,	open	a	document,	spreadsheet,	presentation,	or	video.	Highlight	the	text,	images,	cells,	slides,	or	scenes	you	want	to	comment	on.	To	add	a	comment,	in
the	toolbar,	click	Add	comment	.	Type	your	comment.	Click	Comment.	Chat	with	collaborators	in	a	spreadsheet	On	your	computer,	open	a	document,	spreadsheet,	or	presentation.	At	the	top	right,	click	Show	chat	.	This	feature	won't	be	available	if	you're	the	only	one	in	the	file.	Tip:	If	there	are	many	collaborators	in	the	file,	at	the	top	right,	to	the	right
of	the	avatars,	there	will	be	a	blue	circle	showing	the	number	of	additional	collaborators.	Click	the	blue	circle		Join	chat	.	Enter	your	message	in	the	chat	box.	When	you’re	finished,	at	the	top	right	of	the	chat	window,	click	Close	.	Note:	All	chats	in	Google	Docs,	Sheets,	and	Slides	include	anyone	viewing	the	file.	The	chats	aren't	saved.	Back	to	top
Google,	Google	Workspace,	and	related	marks	and	logos	are	trademarks	of	Google	LLC.	All	other	company	and	product	names	are	trademarks	of	the	companies	with	which	they	are	associated.	SearchClear	searchClose	searchGoogle	appsMain	menu	On	this	page	Note:	Sharing	options	vary	by	group	size:	Up	to	100:	You	can	let	up	to	100	people	with
view,	edit,	or	comment	permissions	work	on	a	Google	Docs,	Sheets,	or	Slides	file	at	the	same	time.	100	or	more:	When	100	people	or	more	are	accessing	a	file,	only	the	owner	and	some	users	with	editing	permissions	can	edit	the	file.	To	let	more	than	100	people	view	your	file	at	the	same	time,	publish	it	as	a	web	page	instead.	Select	the	file	you	want
to	share.	Click	Share	or	Share	.	Enter	the	email	address	or	Google	group	you	want	to	share	with.	To	decide	what	role	people	will	have	on	your	file,	select	Viewer,	Commenter,	or	Editor.	If	your	account	is	eligible,	you	can	add	an	expiration	date	for	access.	Choose	to	notify	people.	If	you	want	to	notify	people	that	you	shared	an	item	with	them,	check	the
box	next	to	Notify	people.	If	you	notify	people,	each	email	address	you	enter	will	be	included	in	the	email.	If	you	don't	want	to	notify	people,	uncheck	the	box.	Click	Send	or	Share.	Learn	more	at	the	Drive	Help	Center	You	can	choose	if	your	file	should	be	available	to	anyone	or	restricted	to	only	the	people	with	access.	If	you	allow	access	to	anyone	with
the	link,	your	folder	won't	restrict	who	can	access	it.	Select	the	file	you	want	to	share.	Click	Share	or	Share	.	Under	“General	access”,	click	the	Down	arrow	.	Choose	who	can	access	the	file.	Learn	more	at	the	Google	Docs	Editors	Help	Center	Stop	sharing	a	document	you	own	Find	the	file	or	folder	in	Google	Drive,	Google	Docs,	Google	Sheets,	or
Google	Slides.	Open	or	select	the	file	or	folder.	Click	Share	or	Share	.	Find	the	person	you	want	to	stop	sharing	with.	To	the	right	of	their	name,	click	the	Down	arrow			Remove	access.	Click	Save.	Restrict	access	to	a	spreadsheet	you	own	Learn	more	at	the	Google	Docs	Editors	Help	Center	On	your	computer,	open	a	document,	spreadsheet,
presentation,	or	video.	Highlight	the	text,	images,	cells,	slides,	or	scenes	you	want	to	comment	on.	To	add	a	comment,	in	the	toolbar,	click	Add	comment	.	Type	your	comment.	Click	Comment.	Chat	with	collaborators	in	a	spreadsheet	On	your	computer,	open	a	document,	spreadsheet,	or	presentation.	At	the	top	right,	click	Show	chat	.	This	feature
won't	be	available	if	you're	the	only	one	in	the	file.	Tip:	If	there	are	many	collaborators	in	the	file,	at	the	top	right,	to	the	right	of	the	avatars,	there	will	be	a	blue	circle	showing	the	number	of	additional	collaborators.	Click	the	blue	circle		Join	chat	.	Enter	your	message	in	the	chat	box.	When	you’re	finished,	at	the	top	right	of	the	chat	window,	click
Close	.	Note:	All	chats	in	Google	Docs,	Sheets,	and	Slides	include	anyone	viewing	the	file.	The	chats	aren't	saved.	Back	to	top	Google,	Google	Workspace,	and	related	marks	and	logos	are	trademarks	of	Google	LLC.	All	other	company	and	product	names	are	trademarks	of	the	companies	with	which	they	are	associated.	SearchClear	searchClose
searchGoogle	appsMain	menu	On	this	page	Note:	Sharing	options	vary	by	group	size:	Up	to	100:	You	can	let	up	to	100	people	with	view,	edit,	or	comment	permissions	work	on	a	Google	Docs,	Sheets,	or	Slides	file	at	the	same	time.	100	or	more:	When	100	people	or	more	are	accessing	a	file,	only	the	owner	and	some	users	with	editing	permissions	can
edit	the	file.	To	let	more	than	100	people	view	your	file	at	the	same	time,	publish	it	as	a	web	page	instead.	Select	the	file	you	want	to	share.	Click	Share	or	Share	.	Enter	the	email	address	or	Google	group	you	want	to	share	with.	To	decide	what	role	people	will	have	on	your	file,	select	Viewer,	Commenter,	or	Editor.	If	your	account	is	eligible,	you	can
add	an	expiration	date	for	access.	Choose	to	notify	people.	If	you	want	to	notify	people	that	you	shared	an	item	with	them,	check	the	box	next	to	Notify	people.	If	you	notify	people,	each	email	address	you	enter	will	be	included	in	the	email.	If	you	don't	want	to	notify	people,	uncheck	the	box.	Click	Send	or	Share.	Learn	more	at	the	Drive	Help	Center
You	can	choose	if	your	file	should	be	available	to	anyone	or	restricted	to	only	the	people	with	access.	If	you	allow	access	to	anyone	with	the	link,	your	folder	won't	restrict	who	can	access	it.	Select	the	file	you	want	to	share.	Click	Share	or	Share	.	Under	“General	access”,	click	the	Down	arrow	.	Choose	who	can	access	the	file.	Learn	more	at	the	Google
Docs	Editors	Help	Center	Stop	sharing	a	document	you	own	Find	the	file	or	folder	in	Google	Drive,	Google	Docs,	Google	Sheets,	or	Google	Slides.	Open	or	select	the	file	or	folder.	Click	Share	or	Share	.	Find	the	person	you	want	to	stop	sharing	with.	To	the	right	of	their	name,	click	the	Down	arrow			Remove	access.	Click	Save.	Restrict	access	to	a
spreadsheet	you	own	Learn	more	at	the	Google	Docs	Editors	Help	Center	On	your	computer,	open	a	document,	spreadsheet,	presentation,	or	video.	Highlight	the	text,	images,	cells,	slides,	or	scenes	you	want	to	comment	on.	To	add	a	comment,	in	the	toolbar,	click	Add	comment	.	Type	your	comment.	Click	Comment.	Chat	with	collaborators	in	a
spreadsheet	On	your	computer,	open	a	document,	spreadsheet,	or	presentation.	At	the	top	right,	click	Show	chat	.	This	feature	won't	be	available	if	you're	the	only	one	in	the	file.	Tip:	If	there	are	many	collaborators	in	the	file,	at	the	top	right,	to	the	right	of	the	avatars,	there	will	be	a	blue	circle	showing	the	number	of	additional	collaborators.	Click	the
blue	circle		Join	chat	.	Enter	your	message	in	the	chat	box.	When	you’re	finished,	at	the	top	right	of	the	chat	window,	click	Close	.	Note:	All	chats	in	Google	Docs,	Sheets,	and	Slides	include	anyone	viewing	the	file.	The	chats	aren't	saved.	Back	to	top	Google,	Google	Workspace,	and	related	marks	and	logos	are	trademarks	of	Google	LLC.	All	other
company	and	product	names	are	trademarks	of	the	companies	with	which	they	are	associated.	SearchClear	searchClose	searchGoogle	appsMain	menu	On	this	page	Note:	Sharing	options	vary	by	group	size:	Up	to	100:	You	can	let	up	to	100	people	with	view,	edit,	or	comment	permissions	work	on	a	Google	Docs,	Sheets,	or	Slides	file	at	the	same	time.
100	or	more:	When	100	people	or	more	are	accessing	a	file,	only	the	owner	and	some	users	with	editing	permissions	can	edit	the	file.	To	let	more	than	100	people	view	your	file	at	the	same	time,	publish	it	as	a	web	page	instead.	Select	the	file	you	want	to	share.	Click	Share	or	Share	.	Enter	the	email	address	or	Google	group	you	want	to	share	with.	To
decide	what	role	people	will	have	on	your	file,	select	Viewer,	Commenter,	or	Editor.	If	your	account	is	eligible,	you	can	add	an	expiration	date	for	access.	Choose	to	notify	people.	If	you	want	to	notify	people	that	you	shared	an	item	with	them,	check	the	box	next	to	Notify	people.	If	you	notify	people,	each	email	address	you	enter	will	be	included	in	the
email.	If	you	don't	want	to	notify	people,	uncheck	the	box.	Click	Send	or	Share.	Learn	more	at	the	Drive	Help	Center	You	can	choose	if	your	file	should	be	available	to	anyone	or	restricted	to	only	the	people	with	access.	If	you	allow	access	to	anyone	with	the	link,	your	folder	won't	restrict	who	can	access	it.	Select	the	file	you	want	to	share.	Click	Share
or	Share	.	Under	“General	access”,	click	the	Down	arrow	.	Choose	who	can	access	the	file.	Learn	more	at	the	Google	Docs	Editors	Help	Center	Stop	sharing	a	document	you	own	Find	the	file	or	folder	in	Google	Drive,	Google	Docs,	Google	Sheets,	or	Google	Slides.	Open	or	select	the	file	or	folder.	Click	Share	or	Share	.	Find	the	person	you	want	to	stop
sharing	with.	To	the	right	of	their	name,	click	the	Down	arrow			Remove	access.	Click	Save.	Restrict	access	to	a	spreadsheet	you	own	Learn	more	at	the	Google	Docs	Editors	Help	Center	On	your	computer,	open	a	document,	spreadsheet,	presentation,	or	video.	Highlight	the	text,	images,	cells,	slides,	or	scenes	you	want	to	comment	on.	To	add	a
comment,	in	the	toolbar,	click	Add	comment	.	Type	your	comment.	Click	Comment.	Chat	with	collaborators	in	a	spreadsheet	On	your	computer,	open	a	document,	spreadsheet,	or	presentation.	At	the	top	right,	click	Show	chat	.	This	feature	won't	be	available	if	you're	the	only	one	in	the	file.	Tip:	If	there	are	many	collaborators	in	the	file,	at	the	top
right,	to	the	right	of	the	avatars,	there	will	be	a	blue	circle	showing	the	number	of	additional	collaborators.	Click	the	blue	circle		Join	chat	.	Enter	your	message	in	the	chat	box.	When	you’re	finished,	at	the	top	right	of	the	chat	window,	click	Close	.	Note:	All	chats	in	Google	Docs,	Sheets,	and	Slides	include	anyone	viewing	the	file.	The	chats	aren't
saved.	Back	to	top	Google,	Google	Workspace,	and	related	marks	and	logos	are	trademarks	of	Google	LLC.	All	other	company	and	product	names	are	trademarks	of	the	companies	with	which	they	are	associated.	SearchClear	searchClose	searchGoogle	appsMain	menu	This	tutorial	demonstrates	how	to	make	a	shared	spreadsheet	for	multiple	users	in
Excel	and	Google	Sheets.	Depending	on	the	version	of	Excel,	users	can	either	share	a	workbook,	or	allow	co-authoring.	In	Office	365,	Microsoft	encourages	users	to	use	OneDrive	and	allow	co-authoring	of	workbooks	on	the	web.	For	this	reason	in	Office	365,	the	traditional	share	feature	has	been	hidden	by	default.	Instead	there	is	a	share	option	in
the	top	right-hand	corner	of	the	screen	which	allows	the	user	to	save	the	workbook	to	OneDrive	and	send	a	co-authoring	link	to	another	user.	Share	Workbooks	In	Office	365,	you	must	enable	the	sharing	of	workbooks	before	you	can	share	the	workbook.	In	the	Ribbon,	go	to	File	>	Options	>	Quick	Access	Toolbar.	In	the	Choose	commands	from	drop
down,	choose	All	Commands.	Scroll	through	the	list	and	add	Track	Changes	(Legacy),	Protect	Sharing	(Legacy),	and	Compare	and	Merge	Workbooks.	The	icons	are	added	to	the	quick	access	toolbar	in	the	title	bar.	To	share	the	current	workbook,	click	on	the	Share	Workbook	icon.	Check	Use	the	old	shared	workbooks	feature	instead	of	the	new	co-
authoring	experience.	Click	OK	to	save	the	workbook.	Track	Changes	in	Excel	Tracking	changes	in	Excel	also	shares	the	workbook,	if	it	is	not	already	shared.	In	the	Quick	Access	Toolbar,	go	to	Track	Changes	>	Highlight	Changes.	Check	Track	changes	which	editing.	This	also	shares	you	workbook.	and	click	OK.	Any	changes	made	to	the	workbook
are	then	shown	by	small	triangles	in	the	top	left-hand	corner	of	the	amended	cell.	If	you	rest	your	mouse	over	a	cell	that	has	been	changed,	the	change	and	author	of	that	change	is	shown	in	a	comment	(note).	The	color	of	the	triangle	is	different	for	each	author.	Co-Author	in	Excel	365	In	Excel	365	you	can	use	the	new	co-authoring	feature	instead.	In
the	top	right	corner	of	the	Excel	screen,	just	below	the	title	bar,	click	on	Share.	To	co-author	this	file	with	other	users,	first	save	the	file	to	OneDrive.	Alternatively,	you	can	send	the	file	in	an	email	as	an	Excel	or	PDF	attachment.	Once	the	file	is	saved	to	OneDrive,	it	can	be	shared	with	other	users.	Type	the	email	addresses	of	the	users	to	send	the	file
to	and	click	the	Send	button.	To	amend	the	link	settings,	click	the	Anyone	with	the	link	can	edit	box	prior	to	sending	the	link.	This	allows	us	to	set	the	“Allow	Editing”	option.	If	you	have	a	OneDrive	paid	subscription,	you	will	also	be	able	to	set	a	password	and	expiry	date	for	the	link	that	you	are	sending.	Set	a	password	and	an	expiry	date	for	the	link.
Copy	Link	and	Outlook	Buttons	Instead	of	Send,	you	could	have	clicked	the	Copy	link	or	Outlook	button.	The	Copy	link	button	creates	a	link	you	can	copy	and	send	to	a	different	user.	The	Outlook	button	opens	a	blank	email	in	Outlook	with	the	link	already	inserted.	Share	Spreadsheets	in	Google	Sheets	In	the	File	menu,	select	Share.	Type	the	email	of
the	person	you	wish	to	share	the	file	with	then	select	their	editing	role:	Viewer	to	view	only,	Commenter	to	add	comments,	or	Editor	to	be	able	to	edit	the	file.	If	the	email	address	is	not	associated	with	a	Google	Account,	you	get	the	following	message.	Click	Share	anyway.	Click	Send	to	send	the	added	person	an	email	notification.	A	“Person	added”
message	appears	on	the	screen.	You	can	see	how	many	people	are	sharing	the	file	by	resting	the	mouse	on	the	Share	button	in	the	top	right	hand	corner	of	the	screen.	To	remove	a	person’s	access	to	the	file,	click	on	the	Share	button	again	then	click	Remove	under	the	person’s	editor	role.	When	Google	Sheets	launched	in	2006,	one	of	its	most
exciting	features	was	real-time	collaboration.	Years	later,	it	still	feels	like	magic	to	share	and	collaborate	on	Google	spreadsheets	with	anyone,	anytime,	anywhere.	Note	that	sharing	and	collaboration	are	slightly	different	features:	Collaboration,	where	you	and	others	work	on	the	same	spreadsheet	at	the	same	time	or	at	separate	times.	Sharing,	where
you	simply	publish	your	spreadsheet	so	others	can	use	it,	and	even	make	their	own	copies	depending	on	permission	levels.	Note:	you	can	share	a	Google	spreadsheet	through	a	desktop	browser	or	a	mobile	device.	This	walk-through	focuses	on	desktop	sharing.	Google’s	help	docs	include	tips	for	mobile	collaboration.	You	can	easily	share	a	Google
spreadsheet	with	anyone	via	their	email	address.	However,	only	people	with	a	Google	Account	will	be	able	to	edit	the	Google	Sheet.	1	–	Open	the	file	you	want	to	share	and	click	the	green	“Share”	button	in	the	upper	right	corner	of	your	screen	2	–	Enter	the	email	addresses	for	each	person	with	whom	you	want	to	share	your	spreadsheet.	3	–	Set
sharing	limits.	When	you	share	a	Google	Sheet,	you	can	choose	what	they	can	do	with	it.	The	levels	are:	View:	The	lowest	level	of	access.	People	can	view,	but	can’t	change	or	share	the	file	with	others	Comment:	People	can	make	comments	and	suggestions,	but	can’t	change	or	share	the	file	with	others.	Edit:	The	highest	level	of	access.	People	can
make	changes,	accept	or	reject	suggestions,	share	the	file	with	others,	add	or	remove	specific	people,	and	copy,	print,	or	download	the	file.	Note:	this	is	the	default	level	of	sharing	in	Google	Sheets.	Advanced	Settings:	If	you	click	the	“Advanced”	link	in	the	lower	right	corner	of	the	“Share	with	others”	window,	you	can	additionally	prevent	editors	from
changing	access	and	adding	new	people,	and	disable	options	to	download,	print,	and	copy	for	commenters	and	viewers.	4	–	Add	a	message	(optional).	Add	a	note	to	explain	why	you	are	sharing	the	spreadsheet	or	to	include	any	special	instructions.	5	–	Send	–	Click	the	blue	“send”	button	in	the	lower-left	corner	of	the	dialog	box	to	share	the
spreadsheet	After	you	share	a	file,	you	can	stop	sharing	it	at	any	time.	You	can	also	prevent	people	from	making	any	changes	or	sharing	your	file.	To	stop	sharing	a	Google	spreadsheet:	Open	the	spreadsheet	Click	Share	At	the	bottom	right	of	the	“Share	with	others”	window,	click	Advanced.	Next	to	the	person,	you	want	to	stop	sharing	with,	click
Delete		Click	Save	changes.	If	you’re	sharing	a	file,	the	owner	or	anyone	with	edit	access	can	change	the	sharing	settings	for	the	file.	Open	the	file	you	want	to	limit.	Click	Share	In	the	bottom	right,	click	Advanced.	Check	the	box	next	to	“Disable	options	to	download,	print,	and	copy	for	commenters	and	viewers.”	Click	Save	changes	and	click	Done.
Note:	You	can	limit	how	people	share,	print,	download,	and	copy	within	Google	Drive,	Docs,	Sheets,	and	Slides,	but	you	can’t	stop	how	others	share	the	file	content	in	other	ways,	including	copying	and	pasting	contents	from	your	file	into	another	file.	Click	Share	In	the	bottom	right,	click	Advanced.	Check	the	box	next	to	“Prevent	editors	from
changing	access	and	adding	new	people.”	Click	Save	changes	and	click	Done.	Note:	If	you	prevent	sharing	of	a	folder,	it	only	applies	to	the	folder.	To	turn	this	on	for	the	files	inside,	you	have	to	change	the	settings	for	the	files	inside.	This	option	is	only	available	for	people	with	educational	or	paid	G	Suite	accounts.	To	set	an	expiration	date	for	a	file:
Click	Share	or	Share		At	the	bottom	right	of	the	“Share	with	others”	window,	click	Advanced.	Under	“Who	has	access,”	move	your	cursor	over	the	person	you	want	to	limit	and	click	Set	expiration		Next	to	“Access	expires,”	click	the	number	of	days	to	change	the	expiration	date.	Choose	a	date	within	one	year	of	the	current	date.	Click	Save	changes.	Up
to	100	people	with	view,	edit,	or	comment	permissions	can	work	on	Google	Docs,	Sheets,	or	Slides	file	at	the	same	time.	When	more	than	100	people	are	accessing	a	file,	only	the	owner	and	some	users	with	editing	permissions	can	edit	the	file.	If	you	need	many	people	to	view	a	file	at	once,	publish	it	and	create	a	link	to	share	to	viewers.	You	can	give
edit	access	to	people	who	need	to	edit	or	comment	on	the	file.	Learn	how	to	publish	a	file.		Publishing	a	file	makes	it	visible	to	everyone	on	the	web.	Be	careful	when	publishing	private	or	sensitive	info.	If	you	have	an	account	through	work	or	school,	your	administrator	can	limit	who	can	view	a	published	file.	If	you’re	an	administrator,	learn	how	to
control	who	can	publish	documents	to	the	web.	To	remove	a	file	from	the	web,	you	must	stop	publishing	it.	Learn	how	to	stop	publishing	a	file.	To	stop	sharing	a	file	with	collaborators,	learn	how	to	change	sharing	permissions.	It’s	easy	to	share	a	Google	Sheet	as	a	template	that	others	can	use	and	edit:	Open	your	Google	Sheet	and	click	the	green
share	button	in	the	upper	right	corner	of	the	screen.	Click	“get	shareable	link”	and	select	“anyone	with	link	can	view,”	then	click	“copy	link.”	You’ll	then	get	a	link	that	looks	like:	lt;spreadsheetID>/edit?usp=sharing	To	use	the	document	as	a	template,	change	the	last	part	of	the	URL	from	/edit?usp=sharing	to	/template/preview	The	link	should	should
look	like	this:	spreadsheetID>/template/preview	Now,	when	someone	opens	the	link	they’ll	see	a	preview	of	the	file	with	a	blue	“Use	template”	button.	If	you	share	a	file	with	people,	you	(or	anyone	with	edit	permissions)	can	change	the	sharing	settings	for	the	file.	Learn	how	to	do	this	here.	If	you	don’t	want	anyone	to	publicly	access	your	file,	stop
publishing	the	file.	People	you	invite	individually	will	show	by	name	when	they’re	in	the	file.	People	you	didn’t	invite	individually	will	show	as	anonymous	animals	when	they’re	in	the	file.	You	might	see	a	name	you	don’t	recognize	or	“anonymous	animals”	viewing	your	document,	spreadsheet,	or	presentation.	This	can	happen	when	a	document	is
shared	publicly	or	with	anyone	who	has	the	link.	Read	more	about	anonymous	sharing	from	Google.	If	someone	shared	a	file	or	folder	with	you	that	you	don’t	want	to	see	anymore,	you	can	remove	it:Go	to	drive.google.com.	On	the	left,	click	Shared	with	me.	Right-click	the	file	you	want	to	remove.	Click	Remove.	Note:	You	can’t	remove	files	stored	in
shared	drives.	If	you’re	collaborating	with	several	people	on	a	single	file,	it	can	be	difficult	to	pinpoint	who	made	certain	changes	and	when.	Fortunately,	Google	Sheets	has	robust	features	for	seeing	who	made	changes	to	a	shared	file.	You	can:	See	all	changes	to	a	file	or	revert	to	a	previous	version.	See	what’s	changed	since	you	last	opened	a	file	See
who’s	viewed	your	file	or	who	you’ve	shared	it	with	See	who	commented,	edited,	moved,	or	shared	a	file	Read	more	about	tracking	changes	here.	Beyond	sharing	in	Google	Sheets,	you	can	also	actively	collaborate	with	others	in	real-time	via	chat.	You	can	also	collaborate	asynchronously	by	assigning	tasks,	sending	email,	and	leaving	comments
directly	in	the	spreadsheet.	If	you	work	on	a	Google	Sheet	at	the	same	time	as	other	people,	you	can	chat	with	each	other	inside	the	spreadsheet.	On	your	computer,	open	a	document,	spreadsheet,	or	presentation.	At	the	top	right,	click	Chat	.	This	feature	won’t	be	available	if	you’re	the	only	one	in	the	file.	Enter	your	message	in	the	chat	box.	When
you’re	finished,	at	the	top	right	of	the	chat	window,	click	Close	.	Note:	All	chats	in	Google	Docs,	Sheets,	and	Slides	include	anyone	viewing	the	file.	The	chats	aren’t	saved.	You	can	easily	email	collaborators	right	from	Google	Sheets.	This	is	especially	helpful	when	you	want	to	ask	questions	about	a	spreadsheet	or	follow	up	on	a	conversation	that’s	too
long	for	comments.	Open	your	Google	Sheets	file.	Click	File	>	Email	collaborators.	(Optional,	shared	drive	files	only)	To	email	all	members	of	the	shared	drive,	check	the	Members	box.	(Optional)	Change	the	email	recipients	or	add	a	subject.	Add	a	message.	(Optional)	To	send	a	copy	of	the	email	to	yourself,	check	the	Send	a	copy	to	myself	box.
(Optional,	Drive	files	only)	To	paste	the	file	directly	into	the	email,	check	the	Paste	the	item	itself	into	the	email	box.	Click	Send.	In	Google	Sheets,	select	the	cell	or	text	you’d	like	to	comment	on.	Click	Add	comment	Enter	your	comment	in	the	box.	(Optional)	To	direct	your	task	or	comment	to	a	specific	person,	enter	a	plus	sign	(+)	followed	by	their
email	address.	You	can	add	as	many	people	as	you	want.	Each	person	will	get	an	email	with	your	comment	and	a	link	to	the	file.	(Optional)	To	assign	the	comment	to	a	specific	person,	check	the	Assign	to	box.	Click	Comment	or	Assign.	Tags#	collaboration#	Google	Sheets	Tips#	Shared	Finances	1	Before	anything	else,	prepare	your	spreadsheet	file
and	place	it	in	a	folder	which	you	can	easily	find.	2	Start	by	opening	your	Gmail	account	and	clicking	on	'Drive'	which	is	found	at	the	left-topmost	part	of	your	screen.	You	will	be	redirected	to	Advertisement	3	Before	making	any	upload	make	sure	that	the	'Upload	Settings'	are	set	correctly.	To	do	this	click	on	the	'gear	icon'->upload	settings->'Convert
uploaded	files	to	google	docs	format'.	4Drag	your	mouse	down	a	little	until	you	find	a	button	that	says	'Upload'	5	Click	Upload	and	a	small	pop	menu	appears	containing	two	upload	types,	may	it	be	"Files"	or	"Folders".	6	Click	'Files'	to	import	your	file.	7	Select	your	file	and	click	'Open'	on	the	pop-up	box.	8Uploading	has	started	9	After	the	file	has	been
uploaded	a	'Share'	link	will	appear.	10	Click	the	'Share'	link	to	invite	friends	or	colleagues.	11	Type	in	the	email	address	of	your	friends	or	colleagues.	12	Set	the	access	type	of	the	recently	added	email,	choose	from	"can	edit",	"Can	Comment"	and	"Can	View".	click	on	Done.	13	After	clicking	"Done",	you	will	then	see	your	uploaded	spreadsheet	marked
with	"Shared".	14	You're	Spreadsheet	must	be	set	to	be	opened	on	"Google	Sheet"	so	that	you	can	edit	it	on	a	spreadsheet	manner.	To	set	it,	Right	click	on	the	file,	select	"Open	with->Google	Sheets".	15	Now	you	can	open	and	edit	your	Spreadsheet	just	like	Excel	and	so	as	your	friend	as	collaborators.	Advertisement	Add	New	Question	Question	Do
all	viewers	need	a	Google	account?	No;	they	will	just	come	up	as	anonymous	viewers.	Ask	a	Question	Advertisement	wikiHow	is	a	“wiki,”	similar	to	Wikipedia,	which	means	that	many	of	our	articles	are	co-written	by	multiple	authors.	To	create	this	article,	volunteer	authors	worked	to	edit	and	improve	it	over	time.	This	article	has	been	viewed	145,503
times.	Co-authors:	8	Updated:	July	24,	2015	Views:	145,503	Categories:	Google	Docs	Print	Send	fan	mail	to	authors	Thanks	to	all	authors	for	creating	a	page	that	has	been	read	145,503	times.	Creating	a	spreadsheet	in	Google	Docs	(now	known	as	Google	Sheets	within	Google	Drive)	is	a	straightforward	process	that	offers	a	quick	way	to	organize
data,	perform	calculations,	and	collaborate	with	others	in	real-time.	To	begin,	simply	access	Google	Drive,	click	on	the	‘New’	button,	then	select	‘Google	Sheets’	from	the	drop-down	menu.	This	action	will	open	a	new,	blank	spreadsheet,	ready	for	your	data	input	and	analysis.	After	completing	these	initial	steps,	you’ll	have	a	functional	spreadsheet	at
your	disposal.	You	can	then	proceed	to	enter	data,	use	formulas	for	calculations,	and	explore	various	formatting	options	to	tailor	the	spreadsheet	to	your	specific	needs.	Additionally,	Google	Sheets	provides	the	convenience	of	cloud	storage,	so	you	can	access	your	spreadsheet	from	any	device	with	an	internet	connection.	Spreadsheets	are	like	digital
Swiss	Army	knives	for	data.	They’re	powerful,	versatile,	and	used	for	a	myriad	of	tasks	across	virtually	all	industries.	From	managing	household	budgets	to	analyzing	complex	financial	data,	the	humble	spreadsheet	is	an	essential	tool	for	organization	and	calculation.	With	the	advent	of	cloud	computing,	Google	Docs,	specifically	Google	Sheets,	has
emerged	as	a	frontrunner	in	the	spreadsheet	space,	offering	accessibility	from	anywhere	and	collaboration	in	real-time.	Why	is	learning	to	make	a	spreadsheet	on	Google	Docs	so	crucial?	Well,	for	starters,	it’s	free,	user-friendly,	and	requires	no	installation	–	you	just	need	a	Google	account.	Whether	you’re	a	teacher	tracking	student	grades,	an
entrepreneur	crunching	business	numbers,	or	just	someone	planning	a	personal	event,	Google	Sheets	can	help	you	manage	information	efficiently	and	effectively.	In	this	article,	we’ll	dive	into	how	you	can	create	a	spreadsheet	using	Google	Docs	and	why	mastering	this	skill	could	be	a	game-changer	in	your	personal	and	professional	life.	Related:	How
to	Create	Tables	in	Google	Docs	Before	we	delve	into	the	specifics,	it’s	important	to	understand	the	outcome	of	following	these	steps.	You	will	have	a	new	Google	Sheet	ready	for	data	entry,	formatting,	and	sharing	with	colleagues	or	friends.	Visit	drive.google.com	and	log	in	with	your	Google	account	credentials.	Once	logged	in,	you’ll	be	directed	to
the	main	Google	Drive	interface	where	you	can	manage	all	your	files	and	create	new	ones.	Click	on	the	‘+	New’	button	on	the	left-hand	side,	then	select	‘Google	Sheets’	from	the	drop-down	menu.	A	new	tab	or	window	will	open	up	with	a	blank	spreadsheet,	symbolizing	a	canvas	ready	for	your	data	masterpiece.	Click	on	a	cell	and	start	typing	to	enter
information.	You	can	navigate	between	cells	using	your	keyboard	or	mouse.	This	is	where	the	magic	happens.	You	can	input	data,	text,	or	formulas.	Each	cell	can	hold	unique	information,	which	can	be	referenced	by	other	cells.	Explore	the	various	features	such	as	formatting	options,	formulas,	and	tools	to	enhance	your	spreadsheet.	Google	Sheets
offers	a	plethora	of	features	including	text	formatting,	cell	coloring,	sorting,	and	even	complex	mathematical	functions	to	make	sense	of	your	data.	Your	Google	Sheets	document	will	save	automatically.	To	share,	click	on	the	‘Share’	button	in	the	top-right	corner	and	enter	the	email	addresses	of	your	collaborators.	You	can	set	permissions	for	each
person,	determining	whether	they	can	view,	comment	on,	or	edit	the	spreadsheet,	facilitating	seamless	collaboration.	BenefitExplanationAccessibilityGoogle	Sheets	is	cloud-based,	which	means	you	can	access	your	spreadsheets	from	any	device	with	an	internet	connection.CollaborationMultiple	users	can	work	on	a	spreadsheet	simultaneously,	making
it	perfect	for	team	projects	and	remote	work.IntegrationGoogle	Sheets	integrates	well	with	other	Google	services	and	third-party	applications,	enhancing	its	functionality.	DrawbackExplanationInternet	DependencyYou	need	an	internet	connection	to	access	the	full	range	of	features,	which	may	not	be	possible	in	all	situations.Features	LimitationsWhile
robust,	Google	Sheets	may	not	have	all	the	advanced	features	or	processing	power	of	some	desktop	spreadsheet	applications.Privacy	ConcernsSome	users	are	hesitant	to	store	sensitive	data	on	the	cloud	due	to	privacy	and	security	concerns.	When	you	embark	on	the	journey	to	create	a	spreadsheet	in	Google	Docs,	keep	in	mind	that	shortcuts	and	tips
can	significantly	enhance	your	experience.	For	instance,	learning	keyboard	shortcuts	for	functions	like	copy	(Ctrl+C)	and	paste	(Ctrl+V),	or	for	inserting	a	new	row	(Ctrl+Shift+Plus)	can	save	you	time.	Familiarize	yourself	with	the	various	formula	functions,	such	as	SUM,	AVERAGE,	and	VLOOKUP,	to	leverage	the	full	power	of	Google	Sheets.	It’s	also
worth	exploring	features	like	conditional	formatting	to	automatically	highlight	key	data	points,	or	data	validation	to	ensure	that	the	data	entered	meets	specific	criteria.	Don’t	forget	that	Google	Sheets	is	part	of	a	suite	of	tools;	you	can	easily	import	charts	into	Google	Docs	or	Slides	for	presentations,	creating	a	seamless	workflow	between
applications.	Access	Google	Drive	and	log	in.	Start	a	new	Google	Sheet	from	the	‘+	New’	button.	Enter	data	into	the	cells	of	the	spreadsheet.	Use	features	like	formatting	and	formulas.	Save	and	share	your	document.	Yes,	Google	Sheets	can	be	set	up	for	offline	use,	but	you	need	to	enable	this	feature	in	Google	Drive	settings	while	connected	to	the
internet.	To	print	your	Google	Sheet,	go	to	‘File’	>	‘Print’,	adjust	your	print	settings,	and	click	on	the	‘Print’	button.	Absolutely,	you	can	import	Excel	files	into	Google	Sheets	by	uploading	the	file	to	Google	Drive	and	opening	it	with	Google	Sheets.	Google	Sheets	is	quite	secure,	with	Google’s	infrastructure	protecting	your	data.	However,	always	be
mindful	of	your	sharing	settings	and	who	has	access.	Yes,	the	‘Version	History’	feature	allows	you	to	view	past	versions	of	your	spreadsheet	and	see	what	changes	were	made.	Stepping	into	the	world	of	Google	Sheets	can	be	transformative	for	both	your	personal	and	professional	life.	With	the	ability	to	organize	data,	perform	complex	calculations,	and
collaborate	with	others,	learning	how	to	make	a	spreadsheet	on	Google	Docs	is	an	invaluable	skill.	Whether	you’re	a	novice	or	looking	to	refresh	your	knowledge,	remember	that	practice	makes	perfect.	Experiment	with	the	various	features,	keep	discovering	new	tricks,	and	watch	as	your	efficiency	with	this	incredible	tool	grows.	Google	Sheets	is
continuously	evolving,	with	new	features	and	add-ons	regularly	introduced.	Stay	curious,	keep	learning,	and	you’ll	soon	be	a	Google	Sheets	whiz,	ready	to	harness	the	power	of	this	versatile	platform.	Matthew	Burleigh	has	been	writing	tech	tutorials	since	2008.	His	writing	has	appeared	on	dozens	of	different	websites	and	been	read	over	50	million
times.	After	receiving	his	Bachelor’s	and	Master’s	degrees	in	Computer	Science	he	spent	several	years	working	in	IT	management	for	small	businesses.	However,	he	now	works	full	time	writing	content	online	and	creating	websites.	His	main	writing	topics	include	iPhones,	Microsoft	Office,	Google	Apps,	Android,	and	Photoshop,	but	he	has	also	written
about	many	other	tech	topics	as	well.	Read	his	full	bio	here.	Last	Updated	on	January	9,	2024	by	Jake	SheridanIn	this	guide,	you	will	learn	all	about	collaborating	and	sharing	in	Google	Sheets.	Google	Sheets	makes	sharing	files	pretty	simple.	It	also	allows	for	multiple	people	editing	the	same	file	in	real-time.	How	to	Share	Google	Sheets	(Quick
Method)	To	share	your	spreadsheet	with	specific	people,	follow	these	five	steps:	Open	the	sheet	you	want	to	share	(that	you	own	or	have	edit	access	for).	Click	Share	in	the	top	right.	Enter	the	email	addresses	you	want	to	share	with.	Choose	the	kind	of	access	you	want	to	give	(edit,	comment,	view).	Click	Send.	Looking	for	more	ways	to	work	as	part
of	a	team	in	Google	Sheets?	Below	you	will	find	step-by-step	instructions	for	sharing	Google	Sheets.	When	working	on	a	Google	Sheets	document,	you	may	find	the	need	to	share	your	work	to	collaborate	with	other	users.	Google	Sheets	makes	it	easy	for	you	to	share	spreadsheets	for	others	to	view,	comment,	and	edit.	Here’s	how	you	can	share	a
Google	Sheets	spreadsheet	that	you	own	to	other	users.	First,	open	the	Google	Sheets	spreadsheet	or	workbook	that	you	want	to	share.	You	can	do	this	by	navigating	to	the	Google	Sheets	homepage,	and	then	searching	for	the	specific	spreadsheet	you	want	to	share.	Once	your	spreadsheet	is	open,	look	for	the	Share	button.	This	is	typically	located	in
the	top	right	corner	of	the	screen.	In	the	sharing	settings	dialog	box	that	appears,	you	can	type	the	email	addresses	of	the	people	you	want	to	share	the	spreadsheet	with.	As	you	type,	Google	Sheets	may	suggest	contacts	from	your	Google	contacts	list.	For	each	person	you	add,	you	can	set	specific	permissions.	Choose	whether	each	person	can	view,
comment,	or	edit	the	spreadsheet.	This	determines	how	much	access	they	have	to	your	spreadsheet.	Once	you’ve	added	all	the	email	addresses	and	set	the	permissions,	click	the	“Send”	button.	This	will	send	an	email	to	each	person	you’ve	invited,	providing	them	with	a	link	to	access	the	spreadsheet.	If	you	prefer	not	to	send	invitations	via	email,	you
can	also	share	the	spreadsheet	by	generating	a	shareable	link.	You	can	attach	this	shareable	link	to	your	own	email	drafts	or	through	other	communication	channels.	Here’s	how	to	get	a	shareable	link	of	a	Google	Sheets	document:	Open	the	spreadsheet	you	want	to	share	in	Google	Sheets.	Ensure	you	have	the	necessary	editing	permissions	for	this
document.	Click	on	the	Share	button	on	the	top-right	corner	of	the	Google	Sheets	interface.	In	the	Share	dialog	box,	adjust	the	share	settings	by	either	adding	emails	in	the	provided	input	box	or	by	editing	the	General	access	options.	Once	you’ve	adjusted	the	share	settings,	click	on	Copy	link	to	copy	a	shareable	link	of	your	document	to	your
clipboard.	Hit	Ctrl+V	(Windows)	or	Cmd+V	(Mac)	to	paste	the	shareable	link	to	your	preferred	document.	The	shareable	link	can	be	placed	in	any	document	that	supports	hyperlinks,	such	as	emails,	PDF,	websites,	or	even	another	Google	Sheets	document.	Here’s	how	you	can	share	multiple	Google	Sheets	files	to	one	or	more	users.	Open	Google
Drive	by	going	to	drive.google.com	in	your	web	browser.	Sign	in	with	your	Google	account	if	you’re	not	already	logged	in.	Locate	the	folder	containing	the	Google	Sheets	documents	you	want	to	share.	You	can	use	the	search	bar	at	the	top	to	find	the	file	by	name	or	browse	through	your	folders.	Select	all	the	files	you	want	to	share	with	other	users.
Click	on	the	first	file	you	want	to	select.	Hold	down	the	‘Ctrl’	key	and	click	on	each	additional	file	you	wish	to	select.	If	you	want	to	select	a	group	of	files	that	are	listed	consecutively,	click	on	the	first	file,	then	hold	down	the	‘Shift’	key	and	click	on	the	last	file	in	the	group.	Right-click	on	the	files	and	select	Share	>	Share	from	the	context	menu.	In	the
Share	N	files	dialog	box,	enter	the	email	addresses	of	the	people	you	want	to	share	the	file	with.	You	can	choose	to	notify	these	users	through	an	email	by	checking	the	Notify	people	checkbox.	You	may	also	assign	the	permission	levels	of	these	users	by	using	the	dropdown	editor.	For	this	example,	we’ll	give	them	Editor	access.	Click	Share	to	proceed.
After	sharing,	you	can	manage	or	revoke	access	at	any	time	by	selecting	these	files	again,	clicking	the	Share	option,	and	then	adjusting	the	settings	in	the	pop-up	dialog	box.	We	can	click	the	Remove	access	option	to	revoke	the	user’s	access	to	the	document	if	needed.	To	amend	sharing	settings	for	a	person	or	group	for	a	Google	Sheets	spreadsheet,
follow	these	steps:	Open	the	Google	Sheets	file	for	which	you	want	to	change	the	sharing	settings.	Once	your	spreadsheet	is	open,	click	on	the	“Share”	button,	located	in	the	top	right	corner	of	the	screen.	This	action	opens	the	sharing	settings	for	the	spreadsheet.	In	the	sharing	settings	panel,	you	will	see	a	list	of	people	and	groups	who	currently	have
access	to	the	spreadsheet.	Find	the	person	or	group	whose	settings	you	want	to	amend.	Next	to	the	person	or	group’s	name,	you	will	see	a	dropdown	menu	indicating	their	current	permission	level	(e.g.,	Viewer,	Commenter,	Editor).	Click	on	this	dropdown	to	change	their	permission	level.	You	can	choose	to	give	them	more	or	less	access	depending	on
your	needs.	After	adjusting	permission	levels,	click	the	Save	button	to	apply	these	changes	to	your	document.	The	individuals	or	groups	will	now	have	the	amended	access	you	set.	When	sharing	a	Google	Sheets	document	with	multiple	tabs,	you	may	want	to	create	a	shareable	link	that	opens	a	specific	tab	in	the	document.	This	can	help	prevent
confusion	and	lead	users	to	the	relevant	sheets.	Here’s	how	you	can	provide	a	link	to	a	specific	sheet	tab	to	other	users.	Open	the	Google	Sheets	workbook	that	contains	the	sheet	you	want	to	share.	Click	on	the	sheet	(tab)	at	the	bottom	of	the	workbook	that	you	want	to	link	to.	This	action	makes	the	chosen	sheet	the	active	one.	Once	the	sheet	is
active,	take	a	look	at	your	browser’s	address	bar.	You	will	see	a	URL	that	looks	something	like	DOCUMENT_ID]/edit#gid=[SHEET_ID].	The	SHEET_ID	at	the	end	of	the	URL	is	a	unique	identifier	for	the	active	sheet.	Copy	the	entire	URL	from	the	address	bar.	This	URL	now	points	directly	to	the	active	sheet	in	your	Google	Sheets	workbook.	Share	the
copied	URL	with	others.	When	someone	clicks	on	this	link,	it	will	open	the	Google	Sheets	workbook	directly	on	the	sheet	(tab)	you	linked,	provided	they	have	the	necessary	permissions	to	view	the	workbook.	This	technique	can	also	help	you	give	users	quick	access	to	certain	tabs	within	the	same	document.	Sharing	just	one	tab	from	a	Google	Sheets
spreadsheet	without	giving	access	to	the	entire	spreadsheet	can	be	achieved	by	using	the	IMPORTRANGE	function.	This	function	allows	you	to	import	a	range	of	cells	from	a	specified	spreadsheet	into	another	spreadsheet.	Here’s	how	to	do	it:	Open	the	Google	Sheets	file	that	contains	the	tab	you	want	to	share.	Click	on	the	tab	at	the	bottom	that	you
wish	to	share.	Note	the	name	of	this	tab	as	you	will	need	it	for	a	formula.	In	the	address	bar	of	your	web	browser,	note	the	URL	of	the	spreadsheet.	It	will	look	something	like	SPREADSHEET_ID]/edit.	Copy	the	[SPREADSHEET_ID]	part	of	the	URL.	Create	a	new	Google	Sheets	file	by	clicking	File	>	New	>	Spreadsheet.	In	the	new	spreadsheet,	select
the	cell	where	you	want	to	start	displaying	the	data	from	the	original	tab.	Enter	the	IMPORTRANGE	function	in	the	selected	cell.	The	syntax	is	=IMPORTRANGE(“spreadsheet_url”,	“range_string”).	Replace	spreadsheet_url	with	the	[SPREADSHEET_ID]	you	copied	earlier,	and	range_string	with	the	name	of	the	tab	and	the	range	you	want	to	import.
After	entering	the	formula,	press	Enter.	A	prompt	may	appear	asking	for	permission	to	access	the	other	spreadsheet.	Click	Allow	Access	to	grant	permission	to	connect	the	two	spreadsheets.	You	should	now	see	the	data	selected	from	the	original	sheet.	Changes	made	to	the	original	sheet	will	reflect	in	the	output	for	IMPORTRANGE.	You	may	now
share	the	new	spreadsheet	with	others.	These	users	will	only	have	access	to	the	data	you’ve	imported,	not	the	entire	original	spreadsheet.	To	share	a	Google	Sheet	with	one	specific	user,	follow	these	steps:	Open	the	Google	Sheets	file	you	want	to	share.	Make	sure	you’re	logged	into	your	Google	account	and	have	the	necessary	permissions	to	share
the	file.	Click	on	the	“Share”	button	located	in	the	top	right	corner	of	the	Google	Sheets	interface.	In	the	“Share	with	people	and	groups”	input	box	that	appears,	type	the	email	address	of	the	user	you	want	to	share	the	sheet	with.	As	you	type,	Google	may	suggest	contacts;	you	can	select	the	correct	one	if	it	appears.	Decide	on	the	access	level	for	this
user.	You	can	choose	between	“Viewer,”	“Commenter,”	or	“Editor.”	A	viewer	can	only	see	the	file,	a	commenter	can	add	comments	but	not	edit	the	content,	and	an	editor	can	make	changes	to	the	file.	Click	the	“Send”	button.	The	user	will	receive	an	email	notification	containing	a	link	to	the	Google	Sheet,	along	with	any	message	you	added.	Sharing	a
single	sheet	of	a	Google	Spreadsheet	with	multiple	users	requires	a	workaround.	Google	Sheets	doesn’t	natively	allow	sharing	individual	sheets	within	a	spreadsheet.	Here’s	a	step-by-step	guide	to	accomplish	this:	Open	the	Google	Sheets	file	containing	the	sheet	you	wish	to	share.	Select	the	sheet	you	want	to	share.	Click	on	the	sheet’s	tab	at	the
bottom	of	the	screen	to	ensure	it’s	active.	Right-click	on	the	sheet	tab	and	select	Copy	to	>	New	Spreadsheet	in	the	context	menu.	Google	Sheets	will	notify	you	that	your	data	has	been	copied	successfully	to	a	new	sheet.	Click	Open	spreadsheet	to	access	this	new	Google	Sheets	document.	Once	you’ve	opened	the	new	spreadsheet,	you	can	now	click
on	the	“Share”	button	in	the	top-right	corner	of	the	screen	to	start	sharing	your	data.	Since	you’ve	only	copied	data	from	a	single	sheet,	users	you	share	it	to	will	only	see	the	copied	data.	Users	without	a	Google	account	can	be	invited	to	collaborate	on	Google	Sheets	documents	through	the	visitor	sharing	feature.	Visitors	can	get	access	for	7	days
after	they	get	an	invitation	and	verify	their	identity.	If	your	Google	account	is	part	of	an	organization,	you	may	encounter	issues	when	trying	to	share	with	non-Gmail	users	or	users	who	do	not	have	a	Google	Account.	If	you	would	like	to	share	a	document	with	non-Gmail	users	through	the	visitor	sharing	feature,	please	request	the	administrator	of	your
Google	account	to	allow	this	option.	Once	visitor	sharing	is	activated,	you	can	follow	the	following	steps	to	invite	non-Gmail	users:	Open	the	Google	Sheets	document	you	want	to	share.	Click	the	Share	button	on	the	top-right	corner	of	the	Google	Sheets	interface.	In	the	provided	text	box	,	enter	the	email	address	of	the	user	you	want	to	share	with	and
press	Enter.	Click	on	the	dropdown	menu	to	determine	what	the	user	can	do	with	the	document.	Google	will	confirm	if	you	are	sure	that	you	want	to	share	to	a	non-Google	account.	Click	Share	anyway	to	proceed.	Click	Send	to	invite	the	non-Gmail	user.	The	recipient	will	receive	an	invitation	to	your	document	where	they	must	verify	their	email
address	through	a	verification	code	to	be	able	to	access	the	document	for	7	days.	If	they	must	collaborate	longer,	they	can	use	the	link	from	the	original	sharing	email	to	verify	their	identity	again.	To	share	a	Google	Sheet	between	different	accounts,	follow	these	steps:	First,	open	the	Google	Sheet	you	want	to	share.	In	the	top-right	corner	of	the
screen,	look	for	a	button	labeled	“Share.”	This	may	also	be	represented	by	an	icon	that	looks	like	a	person	with	a	‘+’	symbol.	In	the	sharing	settings	window	that	opens,	you	can	enter	the	email	addresses	of	the	people	you	want	to	share	the	sheet	with.	Type	in	the	email	addresses	in	the	provided	field.	For	each	email	address,	you	can	set	specific
permissions.	Choose	whether	each	person	can	view,	comment	on,	or	edit	the	sheet.	This	step	is	crucial	for	controlling	how	others	can	interact	with	your	sheet.	After	adding	the	email	addresses	and	setting	permissions,	click	“Send.”	This	will	send	an	email	to	each	person	with	a	link	to	the	sheet	and	your	optional	message.	Copy	this	link	and	send	it	to
those	with	whom	you	want	to	share	the	sheet.	There	are	several	different	methods	you	can	use	to	pull	data	from	one	Google	Sheets	sheet	to	another	sheet	or	spreadsheet.	Here	are	some	of	the	most	widely-used	ways	to	pull	data	across	sheets	or	spreadsheet:	The	Copy-Paste	method	is	the	easiest	way	to	move	data	from	one	sheet	to	another.	To	pull
data	from	one	sheet	to	another	in	Google	Sheets	using	the	copy-paste	method,	follow	these	steps:	Open	the	Google	Sheets	file	that	contains	the	data	you	want	to	copy.	Select	the	data	range	you	want	to	copy.	If	you	want	to	copy	the	entire	sheet,	you	can	press	Ctrl+A	(Cmd+A	on	Mac)	to	select	the	entire	sheet	or	table.	Next,	you’ll	need	to	copy	the
selected	data	to	your	device’s	clipboard.	You	can	do	this	by	right-clicking	the	selected	area	and	choosing	‘Copy’,	or	by	pressing	Ctrl+C	(Cmd+C	on	Mac)	on	your	keyboard.	Now,	navigate	to	the	Google	Sheets	file	where	you	want	to	paste	this	data.	Open	the	specific	sheet	within	this	file	where	the	data	should	be	placed.	In	this	example,	we’ll	create	a
new	empty	sheet	within	the	same	spreadsheet.	Select	the	cell	where	you	want	the	copied	data	to	begin.	This	will	typically	be	the	top-left	cell	of	the	pasted	data.	Paste	the	data.	Right-click	on	the	selected	cell	and	choose	‘Paste’,	or	press	Ctrl+V	(Cmd+V	on	Mac)	on	your	keyboard.	The	data	you	copied	will	be	pasted	starting	from	the	selected	cell.	To



pull	data	from	one	sheet	to	another	in	Google	Sheets	using	the	QUERY	function,	follow	these	steps:	Open	the	Google	Sheets	file	that	contains	the	source	data.	Identify	the	sheet	and	the	range	of	cells	that	contain	the	data	you	want	to	query.	In	this	example,	we	want	to	pull	data	from	the	range	A1:F101	in	a	sheet	labeled	Sheet1.	Open	the	destination
sheet	where	you	want	to	display	the	pulled	data.	Click	on	the	cell	in	the	destination	sheet	where	you	want	the	queried	data	to	begin.	This	cell	will	serve	as	the	top-left	corner	of	the	imported	data	range.	Enter	the	QUERY	function	formula.	The	basic	syntax	of	the	QUERY	function	is	=QUERY(data,	query,	[headers]).	In	this	example:	data	is	the	range	of
cells	that	contain	the	data	you	want	to	query	query	is	the	query	you	want	to	run	on	this	data	written	in	Google	Visualization	API	Query	Language	[headers]	is	an	optional	argument	specifying	the	number	of	header	rows	at	the	top	of	the	data.	Specify	the	data	range	in	the	formula.	Next,	write	your	query	within	quotation	marks.	To	select	all	columns	in
the	source	range,	we’ll	use	the	query	“SELECT	*”	Close	the	formula	with	a	parenthesis	and	press	Enter.	Since	we	used	“SELECT	*”	as	the	query,	this	function	returns	the	entire	source	range	into	the	new	sheet.	To	pull	data	from	one	Google	Sheet	to	another	using	the	IMPORTRANGE	function,	follow	these	steps:	Open	the	Google	Sheet	where	you
want	to	import	the	data.	This	is	your	destination	sheet.	Locate	the	URL	of	the	source	Google	Sheet	(the	sheet	from	which	you	want	to	import	data).	You	can	find	this	in	the	address	bar	of	your	web	browser	when	the	source	sheet	is	open.	Decide	on	the	range	of	cells	in	the	source	sheet	that	you	want	to	import.	In	our	example,	we	want	to	pull	the	data	in
the	cell	range	A1:F26	in	the	sheet	named	Data.	Click	on	the	cell	in	your	destination	sheet	where	you	want	the	imported	data	to	begin.	This	cell	will	serve	as	the	top-left	cell	of	the	imported	data.	Type	in	the	IMPORTRANGE	formula.	The	syntax	for	IMPORTRANGE	is	=IMPORTRANGE(“spreadsheet_url”,	“range_string”).	Here,	“spreadsheet_url”	is	the
URL	of	the	source	sheet	and	“range_string”	is	the	range	of	cells	you	noted	in	Step	3,	in	the	format	‘sheet_name!range’.	Replace	“spreadsheet_url”	in	the	formula	with	the	actual	URL	of	your	source	sheet.	Make	sure	to	keep	the	URL	within	double	quotes.	Replace	“range_string”	with	the	actual	range	of	cells	you	want	to	import,	ensuring	it’s	within
double	quotes	and	correctly	formatted.	For	instance,	if	you’re	importing	cells	A1	to	F26	from	a	sheet	named	“Sheet1”,	the	range	string	would	be	“Sheet1!A1:F26”.	Press	Enter	to	apply	the	formula.	The	first	time	you	use	IMPORTRANGE	from	a	new	source	sheet,	Google	Sheets	will	prompt	you	to	connect	these	sheets.	Click	“Allow	access”	to	permit	the
connection.	After	allowing	these	sheets	to	connect,	you’ll	now	see	the	data	pulled	from	the	other	spreadsheet.	Pulling	data	from	another	sheet	in	Google	Sheets	using	linked	cells	is	a	straightforward	process.	Here	are	the	steps	to	do	it:	Open	the	Google	Sheets	file	that	contains	the	source	sheet	(the	sheet	you	want	to	pull	data	from).	Navigate	to	the
source	sheet	and	identify	the	range	of	cells	you	want	to	link.	For	this	example,	we	want	to	pull	data	from	the	range	A1:F101.	Type	the	range	you	want	to	pull	data	from.	Ensure	that	you	mention	the	sheet	name	in	the	cell	reference.	Enclose	this	range	with	curly	braces	to	let	Google	Sheets	know	you	want	to	return	an	array.	Google	Sheets	should	now
return	an	array	corresponding	to	the	provided	range	in	the	formula.	Yes,	multiple	users	can	edit	a	Google	Sheets	document	at	the	same	time.	For	this	to	be	possible,	each	user	must	have	edit	permissions	for	that	particular	document.	When	multiple	users	are	editing	the	same	sheet,	each	user	is	assigned	a	random	color.	Whenever	a	user	selects	a	cell,
other	users	will	be	able	to	see	their	selection	highlighted	with	their	assigned	color.	The	Share	button	in	Google	Sheets	is	typically	located	in	the	top-right	corner	of	the	screen.	It	is	represented	by	a	button	with	the	word	“Share”	or	as	an	icon	resembling	a	person	with	a	‘+’	symbol.	You	can	hover	your	mouse	over	the	Share	button	to	see	at	a	glance	who
has	access	to	the	document.	When	you	click	the	Share	button,	a	new	pop-up	dialog	box	will	open,	allowing	you	to	add	people	by	their	email	addresses	or	to	copy	a	shareable	link	to	the	document.	You	can	also	access	the	share	dialog	box	by	clicking	File	>	Share	>	Share	with	others.	If	you	can’t	share	a	Google	Sheet,	there	are	several	potential	reasons:
If	the	spreadsheet	was	created	by	another	user,	you	might	not	have	the	necessary	permissions	to	share	it	with	others.	Only	owners	or	users	with	editing	rights	can	share	Google	Sheets.	If	your	account	belongs	to	a	Google	Workspace	(formerly	G	Suite),	your	organization’s	administrator	might	have	restricted	sharing	settings.	Some	organizations	limit
sharing	outside	their	domain	or	completely	disable	sharing	for	security	purposes.	Ensure	that	your	device	has	a	stable	Internet	connection.	A	poor	or	unstable	internet	connection	can	prevent	the	sharing	options	from	loading	correctly.	There	are	some	cases	where	browser-related	problems	can	interfere	with	Google	Sheets’	functionality.	It	may	also	be
possible	that	an	add-on	or	browser	extension	may	be	causing	this	issue.	Trying	a	different	browser,	incognito	mode,	or	clearing	the	cache	might	resolve	this.	There	are	rare	occasions	where	the	issue	might	be	on	Google’s	end,	with	their	servers	experiencing	downtime	or	technical	difficulties.	When	sharing	Google	Sheets	documents,	users	can	grant
specific	users	or	groups	permission	levels	which	affect	what	the	user	is	able	to	do	with	the	document.	Currently,	there	are	four	primary	permission	levels:	By	default,	users	who	create	a	file	are	given	the	Owner	role	for	that	document.	Owners	have	full	access	to	view	and	edit	documents	that	they	own.	The	owner	also	has	control	over	the	sharing
settings	of	the	document.	While	the	creator	of	the	spreadsheet	is	automatically	ownership	can	be	transferred	to	another	user	if	needed.	Viewers	can	only	see	the	spreadsheet.	They	cannot	make	any	changes	to	the	content	or	structure	of	the	sheet.	This	level	is	ideal	for	when	you	need	to	share	information	without	the	risk	of	it	being	altered.
Commenters	can	also	view	the	document	But	they	can	also	have	the	ability	to	add	and	reply	to	comments.	This	is	useful	for	collaborators	who	need	to	provide	feedback	or	input	without	altering	the	actual	data	in	the	spreadsheet.	Editors	have	full	access	to	the	spreadsheet.	They	can	add,	modify,	and	delete	content,	including	changing	the	structure	of
the	sheet	(like	adding	or	removing	rows	and	columns),	modifying	formulas,	and	changing	formatting.	This	level	of	access	should	be	reserved	for	trusted	collaborators	who	need	to	actively	work	on	the	spreadsheet.	By	default,	editors	also	have	the	ability	to	change	permissions	and	share	the	workbook	with	others.	However,	owners	can	adjust	the	Share
settings	to	prevent	editors	from	being	able	to	edit	permission	levels	themselves.	Yes,	it’s	possible	to	restrict	access	to	a	spreadsheet	or	certain	parts	of	a	spreadsheet	in	Google	Sheets.	Here’s	some	of	the	methods	you	can	use	to	restrict	access	in	Google	Sheets:	A	straightforward	way	to	restrict	access	in	Google	Sheets	is	by	adjusting	the	document’s
sharing	settings.	By	adjusting	these	settings,	document	owners	can	restrict	access	to	a	select	group	of	people	or	make	the	sheet	accessible	only	to	those	with	a	specific	link.	Users	can	be	given	different	levels	of	permission,	such	as	viewing,	commenting,	or	editing.	You	can	access	the	Share	settings	by	clicking	File	>	Share	>	Share	with	others	or
through	the	Share	button	on	the	top-right	corner	of	the	Google	Sheets	interface.	Within	your	Google	Sheet,	you	can	also	protect	specific	ranges	or	entire	sheets.	You	can	access	this	feature	by	clicking	Data	>	Protect	sheets	and	ranges.	This	feature	allows	you	to	restrict	users	from	changing	data	in	certain	cells	or	sheets	while	leaving	other	parts	of	the
document	open	for	editing.	For	example,	a	budget	spreadsheet	might	have	protected	cells	for	salary	information,	ensuring	only	authorized	personnel	can	modify	these	figures.	To	give	everyone	access	to	a	Google	Sheet,	you	can	adjust	the	sharing	settings	to	allow	anyone	with	the	link	to	view,	comment	on,	or	edit	the	sheet.	Here’s	how	to	do	it:	First,
open	the	Google	Sheet	you	want	to	share.	In	the	top-right	corner	of	the	sheet,	click	on	the	“Share”	button.	This	is	typically	represented	by	a	button	labeled	“Share”	or	an	icon	that	looks	like	a	person	with	a	‘+’	symbol.	You	may	also	select	File	>	Share	>	Share	with	others.	In	the	sharing	settings	window,	select	“Anyone	with	the	link.”	This	option	will
make	the	sheet	accessible	to	anyone	who	has	the	link.	Choose	the	access	level	you	prefer	for	the	document:	Viewer:	People	can	view	the	sheet	but	cannot	make	any	edits.	Commenter:	People	can	view	and	comment	but	cannot	make	edits.	Editor:	People	can	view,	comment,	and	make	edits	to	the	sheet.	In	this	example,	we’ll	set	the	access	level	to
“Viewer”.	This	means	that	everyone	with	the	link	can	view	the	entire	document	but	not	make	edits	Click	on	Copy	link	to	copy	a	shareable	link	of	the	document	to	your	clipboard	You	can	now	share	the	copied	link	through	email,	messaging,	or	any	other	means	of	communication.	Anyone	with	this	link	can	access	the	sheet	based	on	the	permissions
you’ve	set.	Which	users	can	access	your	Google	Sheets	depends	on	the	sharing	settings	you	have	configured	for	each	document	Your	document’s	sharing	settings	is	likely	to	be	set	to	either	one	of	the	following	options:	Restricted	to	the	Owner	–	If	you	haven’t	shared	the	sheet	with	anyone	else	and	General	access	is	set	to	Restricted,	only	you	can
access	the	document	with	your	Google	account.	Restricted	to	Specific	People:	If	you	have	shared	the	sheet	with	specific	people,	only	those	with	whom	you	have	shared	the	sheet	(via	their	email	addresses)	and	assigned	specific	roles	(viewer,	commenter,	or	editor)	can	access	it.	Anyone	with	the	Link:	If	you	set	the	sheet	to	be	accessible	by	“anyone	with
the	link,”	then	anyone	who	has	the	link	can	access	the	sheet.	This	includes	people	who	don’t	have	a	Google	account.	The	level	of	access	(view,	comment,	or	edit)	depends	on	the	permissions	you	have	set.	Domain	Restrictions:	If	you	are	using	a	Google	Workspace	account,	your	Google	administrator	can	set	domain-level	restrictions	for	files	made	with
an	account	underthat	workspace.	Typically,	only	people	within	your	organization	might	be	able	to	access	the	document	Public	on	the	Web:	In	some	cases,	a	Google	Sheets	document	can	be	made	public	on	the	web,	meaning	anyone	can	find	and	access	it	without	needing	a	specific	link.	This	option	can	be	accessed	through	File	>	Share	>	Publish	to
web.	FAQs	(about	sharing	&	collaborating	in	spreadsheets)	Got	questions?	Here’s	some	frequently	asked	questions	related	to	sharing	in	Google	Sheets:	Can	multiple	users	edit	Google	Sheets	at	the	same	time?	At	any	time,	a	Google	Sheet	can	only	be	edited	by	100	open	tabs	or	devices.	How	many	users	can	use	Google	Sheet?	Up	to	100	people	with
view,	edit,	or	comment	permissions	can	work	on	a	Google	Sheets	at	the	same	time.	This	limit	also	applies	to	Docs,	Sheets,	and	Slides	files.	What	is	collaborators	in	Google	Sheets?	Viewer—People	can	view	the	file,	but	not	edit	or	add	comments.	Commenter—Can	add	comments,	but	not	edit	content.	Editor—Can	add	content,	edit	and	add	comments.
(this	is	the	one	to	pick	if	you	want	team	members	to	update	the	file	themselves).	Click	the	“Share”	button	in	the	top-right	corner	of	your	sheet.	Select	on	“Get	link”	and	then	“Anyone	with	the	link”.	Copy	the	link	and	share	it	with	the	non-Google	account	user.	Optional	step:	tell	them	to	stop	being	silly	and	get	a	Gmail	account	 	Click	the	Share	button
and	then	Anyone	with	the	link.	In	a	shocking	turn	of	events,	selecting	this	will	cause	your	spreadsheet	to	be…	shared	with	Anyone	with	the	link	Just	be	sure	to	set	the	the	level	of	access	that	you	want	to	give.	If	you	allow	access	to	anyone	with	the	link,	your	folder	won’t	restrict	who	can	access	it.	Can	2	owners	have	one	Google	spreadsheet?	You	can
give	someone	else	(with	their	own	Google	Account)	access	to	your	files	and	folders.	You	can’t	give	someone	with	a	work	or	school	account	permission	to	use	your	files	or	folders.	For	the	move	to	go	through,	the	person	you	want	to	own	the	file	or	folder	must	accept	your	request.	By	default,	Google	Sheets	are	set	to	be	private.	This	setting	lets	only	the
people	you	give	permission	to	in.	If	you’re	working	in	a	Google	Apps	area	where	documents	aren’t	private	by	default,	or	if	you’d	like	to	make	a	document	private,	click	the	Share	button.	Summary	Hopefully	this	guide	has	given	you	an	overview	of	collaboration	in	Google	Sheets.	Explore	some	of	the	other	useful	resources	on	Sheets	for	Marketers:


